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Troubleshooting Federal
Child Count Reports
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The Ohio Department of Education funds development of EMIS training materials
as part of the EMIS Alliance grant. There is an expectation that ITCs will utilize these
materials in training provided to your districts. That said, there are restrictions on
use of the EMIS Alliance materials as follows: Materials developed as part of the
EMIS Alliance program must be provided at no cost to your training participants. If
you utilize the EMIS Alliance training materials — in whole or in part — you must not
charge participants a fee to attend the class where the materials are used. Likewise,
you may not use the materials or any portion thereof in any event where a fee is
charged to attend. Exceptions must be approved in writing by the Department of

Education in advance of scheduling/promoting any event which may violate these
restrictions.

Questions regarding appropriate use of EMIS Alliance materials, or requests for
exception to the restrictions noted above, should be directed to Melissa Hennon
[Melissa.Hennon@education.ohio.qov].
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Overview

* The Federal Child Count (FCC)
* Includes students with disabilities who are receiving special education

services according to their IEPs as of October 31
* |Is used in determining the amount of Special Education Part-B IDEA
and Early Childhood Special Education funds allocated to the state
* |s collected from all LEAs except for ESCs and JVSDs through the
Education Management Information System (EMIS) and is submitted
to the US Department of Education (USDOE)
* This presentation will focus on troubleshooting the EMIS FCC

Reports, which are generated throughout the EMIS data

EMIS

submission process

Alliance

EMIS Data Collections and the FCC Snapshot

* Collections containing the FCC report
* Beginning of Year Student (S) Collection
* SOES Beginning of Year Student (S) Collection
* Collections are scheduled to close December 20, 2021

e FCC will close when the above collections close

* There is no appeal for the FCC
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FCC Reports

* Level 2 Reports
* (FCCD-001) Federal Child Count Detail
* (FCCS-001) Federal Child Count Statement of Assurances

* FCC Reports are updated nightly
* Can contain data reported by other LEAs

* Review the most recent version of the reports throughout the
data collection process

* Submit updated EMIS data to make corrections to the reports

\ EMIS
\
4
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Beginning of Year Student Collection (FY22)
FY22-S-TRAD Init: Collection required for all Traditional Districts, JVSDs, ESCs, and State Supported Schools. Source file(s) for GI, FS, FD, FN, GE. ...
Submissions: September 09, 2021 - December 20, 2021 (48 days till close)
n was submitted October 28, 2021 at 02:40:06 PM by
pleted (October 28, 2021 at 03:40:16 PM)
SOES Beginning_of Year Student Collection (FY22)
FY22-S required for all Community Scheols. Source file(s) for GI, FS, FD, FN, GE, FENG
ugust 02, 2021 - December 20, 2021 {48 days till close)
af The collection was submitted October 28, 2021 at 03:27:31 PM
ion Status: g C (October 28, 2021 at 03:27:35 PM)
Submission Number: 15 (attempt 1) nas)
Actic
\ EMIS
\
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FCC Reports

ollection Reque o by 0 Progre: Repo A e assage es0

Data Feedback Reports and Files

Pre-Submission to ODE I Post-Submission and Processing b
Level 1 Details | Highlights and Recent | Level 2Details | !

d Files Details

Level 2 Details

Choose the filter criteria then click the Show Reports link to generate the list of Level 2 reports matching these criteria. To see the option to Generate a single .zip file for all
reports (.csv), you must select a single Report Name, or select a single LEA and a single Collection Request or a single Category.

LEA: [Use IRN below v Collection Request: [ FY22-5-TRAD Init ~ Data Set: [21 v | Schaol Year: [All__v| Category:

LEA IRN: Report Name: Last Activity Wi [ Show closed collections
Processed onorafters| | (mm/edi) — Ay

With Data Only: [ £xclude reports with 0 rows

FCC was added to the
Group By: ® Collection Request () LEA () Level 2 Report () Category () Data Set () Nane File Format: @ csv O HmL filter in thiS example

Date

texthoxes

Student Reports

i ~Select “Show Reports”

Data

Collection Request / Report Name LEA Fatal Critical Warn Info Total Category set Process Date Last Upd Date Submission  Help Page

of Year Student Collection (F¥22) (202251TRD)

15
o
It

1423 Student Reperts E 11/01/21 17:16 11/02/21 03:10 & Unknown

1) Federal Child Count Detsil

Eelo ...

o
o

15 Student Reports s 11/01/21 17:16 11/02/21 02:10 € Unknouin

ports | Export report information to 3 .csv file
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Formatting the FCC Detail Report

* Open the (FCCD-001) Federal Child Count Detail Report
* Wrap text header row
* Freeze top row

Expand all columns

Apply filters

Better yet, run your macro!
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Quick Check

The Federal Child Count Detail
Report contains student detail
data as it pertains to the
count. This report is critical in
the data review and error
correction process and should
be carefully reviewed for
accuracy and completeness.

* Are you using the most recent
version of the report?

* Are you able to open and format
the CSV report to begin the review
process?

* Can you apply filters to all
columns?

EMIS
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Troubleshooting
the Federal Child Count
Detail Report
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| Troubleshooting the FCC Detail Report

The next series of slides will review data contained in the
report including

* Severity Codes and Numbers

* Federal Child Count Flag

* Who is and is not included in my FCC?

* FCC Report Data

* Status Codes and corrective actions

EMIS

\ -F— 1
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Severity Numbers and Codes
Severity Numbers (ERR SEV NUM) are aligned with Severity Codes
* Report is sorted least severe to most severe
* Severity Code will be noted for each Status Code
* Review all students regardless of Severity Code
A B C D E F G H %
SEVERITY ERR SEV
1 |LEAIR~|BIdg If ~| CODE [~]SSID ~|EmisID [~|Last Nan~|First Nan~| Middle Nan ~ NUM .
2 | 404040 101010 I VX2210168 123456822 Last Name First Name Middle Name I
3 1404040 101010 | UF3557988 123457014 Last Name First Name Middle Nam / 15
4 404040 101010 | V8(| _ Informational - 15 |7 NW 15
5 1404040 1010101 C81 . First Na iddle Name 15
N\ W - Warning - 39 L
C —Critical - 63
\ F - Fatal - 79 -
\ "::Il':ﬁs' 12
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Federal Child Count Flag

FED CCT FLAG
Y — Student is intended to be included in the Federal Child Count
* N — Student not included in the Federal Child Count
* Review all students on the report regardless of flag

I J K L M N (o] P Q R
FED CCT LEGAL DISAB STDNT
STATUS FED CCT |FED CCT DIST OF CNDTN AGE DIST LRE FED CCT
| CODE ~ FED CCT STATUS CODE DESCR ~|FLAG ~ |LRE COl~ RES IR~ CODE~|NUMEBI ~ | SRC CO[ ~ | DIST LRE SRC DESCR - |ALTIR ~
[ FCODO8 No errors identified in ODE processing Y IESS 404040 16 4 8 GE Record
| FCODO8 No errors identified in ODE processing Y IES1 404040 16 5 8 GE Record
FCOO08 No errors identified in ODE processing Y IES5 404040 16 4 8 GE Record
| FCOOD7 Student excluded- conflict in where student should count N 404040 15 19 8 GE Record
! FCOD06 Student counting in Alternate District - Does not count in your district [N 404040 1 a9 A Sent Reason =AU or JP 616161
\ EMIS
‘ ke LgliEE
\ Alliance
13
Who is included in my FCC?
* In most cases, students count at their resident district except for
students attending -
* Community Schools
* STEM Districts
* Ohio School for the Blind
* Ohio School for the Deaf
* Buckeye United (DYS)
| * Pilot Programs
' * Non-Public students receiving related services count at the traditional
district providing the related services if active IEP event is reported as of
\ October 31
\ EMIS
‘ S
\ Alliance
14
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Who is not included in my FCC?

* Students with a disability as of October 31, who are not
being reported with an active IEP event as of October 31

* Students reported with the following IEP outcomes
* |EPR — IEP Complete — Parental Refusal
* [ENS — IEP Complete — Not Served
* |EDP — |IEP Resulted in Due Process

* Refer to the FCC Level 2 Report Explanation, section “Include
in USDOE Count” for additional information and exceptions

EMIS

~J)
5.
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FCC Report Data

* Disability Condition Code

* Student must be reported to EMIS with a disability as of October
31 to be included on the report

* Review for accuracy

* Student Age Number
* Student’s age as of October 31

I J K L M N (o] P Q R

FED CCT LEGAL | DISAB STDNT

STATUS FED CCT FEDCCT DIST OF| CNDTN AGE DIST LRE FED CCT
CODE | ~ | FED CCT STATUS CODE DESCR ~ FLAG ~ LRE COIl ~ RES IR ~] CODE ~ NUMBI ~| SRC COL ~ ' DIST LRE SRC DESCR  ~ ALTIR ~
FCO008 No errors identified in ODE processing Y IESS 404040 16 4 8 GE Record

FCO008 No errors identified in ODE processing Y IES1 404040 16 5| 8 GE Record

FCO008 No errors identified in ODE processing Y IESS 4040408 16 4 8 GE Record

FCO007 Student excluded- conflict in where student should count N 404040 15 19 8 GE Record

FCO006 Student counting in Alternate District - Does not count in your district N 4040404 1 9A Sent Reason =AU or JP 616161

EMIS
.
Alliance
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FCC Report Data, cont’d

* Legal District of Residence
* FED CCT ALT IRN
* Populated for Status Code FC0006 with LEA IRN where the student will count

* Sent Reasons and IRNs
* Displays if relevant to the FCC

L M N (o] P Q R S T u vV W X
LEGAL PISAB STDNT SENT SENT LEVEL 2
FED CCT | DIST OF ENDTN AGE DIST LRE FED CCT |ADMSN|REASON 1 SENTTO 1 REASON 2 SENT TO 2 |REC TYPE
LRE COL[ ~| RES IR ~ | CODE ~ | NUMBI ~ | SRC COI[ ~ DIST LRE SRC DESCR | +]| ALT IR ~ |DATE ~|CODE |~ |LEAIRN |~ |CODE |~ |LEAIRN|~|CODE |~
IESS 404040 16 4 8 GE Record 00:00.0 FCCD-001
IES1 404040 16 5 8 GE Record 00:00.0 FCCD-001
IESS 404040 16 4 8 GE Record 00:00.0 FCCD-001
404040 15 19 8 GE Record 00:00.0} FC 515151 FCCD-001
404040 1 9 A Sent Reason = AU or JP| 616161]00:00.0{JP 999999 FCCD-001
\ EMIS
\ Alliance
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. FCC Report Data, cont’d

* FED CCT LRE Code — Least Restrictive Environment Code
* If this is blank, the student is not included in the count
* Value comes from |EP, FN270, or is derived

* DIST LRE SRC CODE and DIST LRE SRC DESCR

* Source codes indicate what data the report is looking at

* Use in combination with the Status Code value to determine what is being
reported for each student

I J K L M N ] P Q
FED CCT LEGAL DISAB STDNT
STATUS FED CCT|FED CCT |DISTOF CNDTN AGE DIST LRE
CODE | ~  FED CCT STATUS CODE DESCR ~ | FLAG | ~ | LRE COIL ~ |RES IR ~ | CODE ~  NUMBI ~| SRC COI ~ | DIST LRE SRC DESCR |~
FCO008 No errors identified in ODE processing Y IESS 1404040 16 4 8 GE Record
FCO008 No errors identified in ODE processing Y IES1 1404040 16 9| 8 GE Record
FCO008 No errors identified in ODE processing Y IESS 404040 16 4 8 GE Record
FCO007 Student excluded- conflict in where student should count N 404040 15 19 8 GE Record
FCOO06 Student counting in Alternate District - Does not count in your district N 1404040 1 9 A Sent Reason = AU or JP
FCO006 Student counting in Alternate District - Does not count in your district N 373737 3 10 8 GE Record
\ EMIS
\
\ Alliance
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" DIST LRE Source Codes

' *1 - No Disability on October 31
* 3 - Student’s age is not 3 - 21
*5-No IEP Reported
e 7 -FN270 Override
* 8 - GE Record

I J K L M N o P Q

FED CCT LEGAL DISAB STDNT
STATUS FED CCT FEDCCT DISTOF CNDTN AGE DIST LRE
CODE ~ FED CCT STATUS CODE DESCR ~ FLAG ~ LRE COL ~ RES IR ~ CODE ~ NUMBI ~ ISRC COI ~ DIST LRE SRC DESCR  ~
FCO008 No errors identified in ODE processing Y IESS 404040 16 4 8 GE Record
FCO008 No errors identified in ODE processing Y IES1 404040 16 5 8 GE Record
FCO008 No errors identified in ODE processing g IESS 404040 16 4 8 GE Record
FCO007 Student excluded- conflict in where student should count N 404040 15 19 8 GE Record
FCO006 Student counting in Alternate District - Does not count in your district N 404040 s L 9lA Sent Reason = AU or JP
FCO006 Student counting in Alternate District - Does not count in your district N 373737 3 10 8 GE Record

1\ EMIS

1\ ~
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- DIST LRE Source Codes, cont’d

* 9 - How Received = 6
g * FED CCT LRE CODE will be IE39 Ages 5 and up, Not Grade Level PS
I\ | * FED CCT LRE CODE will be IE39 Ages 6 and up, Grade Level PS
* C - How Received = 6 and Grade Level =PS
* FED CCT LRE CODE will be IE51 if Ages 3 to 5 and Grade Level PS
* A - Sent Reason = AU or JP
* FED CCT LRE CODE will be IE39 if age 6 or older and IE51 if age 3-5

* B - Changed to DYS LRE (Appears only on DYS report)

1 ) K L M N o P Q

FED CCT LEGAL DISAB STDNT

STATUS FED CCT FEDCCT DISTOF CNDTN AGE DIST LRE

CODE ~ FED CCT STATUS CODE DESCR ~ FLAG ~ LRE COL ~ RES IR ~ CODE ~  NUMBI -] SRC COI[ ~ DIST LRE SRC DESCR  ~

FCO008 No errors identified in ODE processing Y IESS 404040 16 4 8 GE Record

FCO008 No errors identified in ODE processing 2 IES1 404040 16 E 8 GE Record

FCO008 No errors identified in ODE processing Y IESS 404040 16 4 8 GE Record

FCO007 Student excluded- conflict in where student should count N 404040 15 19 8 GE Record

FCO006 Student counting in Alternate District - Does not count in your district N 404040 1 qA Sent Reason = AU or JP
1\ FCOO06 Student counting in Alternate District - Does not count in your district N 373737 3 19 8 GE Record EMIS

\

\ e
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Quick Check * Are all students appearing on the

, . report as expected?
The Federal Child Count Detail

Report contains data specific * Has someone verified the data for
to students wlth disabilities. accuracy?
Understanding each column
of data is important to begin * Has updated EMIS data been
analyzing the data for submitted to correct any
accuracy and completeness. ) ]
| There is not an error for inaccuracies on the report?
| . )
' everything, so time spent
‘ reviewing all data on the
' report is recommended.
\ EMIS
! He
\ Allia.nce
21
FED CCT Status Codes
FED CCT STATUS CODE and FED CCT STATUS CODE DESCR
* Indicates the status of a student as it relates to inclusion in the count
* Indicates that a data issue exists or that no errors are identified
 Data with no errors on the report should still be reviewed for accuracy
E F G H I J K L M N
FED CCT LEGAL DISAB
STATUS FED CCT FED CCT DIST OF CNDTN
EmisID |~ |Last Nan ~ First Nan ~ Middle Nan ~|CODE ~ | FED CCT STATUS CODE DESCR - |FLAG |~ LRE COIl ~ | RES IR ~ | CODE ~
’ 123458169 Last Name First Name Middle Name |FCO004 No IEP reported for Oct 31 date N 404040 15
123458670 Last Name First Name Middle Name |FCO004 No IEP reported for Oct 31 date N 404040 15
123458166 Last Name First Name Middle Name |FC0003 CIEP most recent IEP- should be no disability N 424242 1
,‘ 123458165 Last Name First Name Middle Name |FC0003 CIEP most recent IEP- should be no disability N 212121 10
123457205 Last Name First Name Middle Name |FC0002 Unable to translate LRE- must report FN270 element N 404040 1
\ EMIS
] _He
\ Allia.nce
22
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FED CCT Status Code FCO001

Filter on FCO001
* On Oct 31 Student age is outside the 3-21 included range (Fatal)
* Source Code 3 - Student age is not 3 -21

* FED CCT FLAG-N
* View the student’s reported date of birth on the Student
Demographic (Gl) Record to confirm age
* If the student’s date of birth is incorrect, make the correction and

submit updated EMIS data

EMIS
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Alliance
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FED CCT Status Code FC0002

Filter on FC0002
* Unable to translate LRE-must report FN270 element (Critical)

¢ Source Code 7 - FN270 Override
* or Source Code 8 - GE Record

* FED CCT Flag - N
* As of October 31, the student’s IEP Outcome (LRE) must agree

j ; with the student’s age and grade level
* For ages 3-5 and in preschool, the LRE should be in the IE51 to IE72

range, if not report an LRE within this range on the FN270

| * For ages 5 and over and in kindergarten or higher, LRE should be in

g . gher, L
yl]\le2|7E013 to IE39 range, if not report an LRE within this range on the

EMIS

i
Alliance
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Age, Grade Level, and Expected LRE

* Age 3 to 5, Preschool Grade Level - Count as Preschool Student

* Preschool LRE Expected (IE51-I1E72)

* Age 4, Kindergarten Grade Level - Count as Preschool Student

* Preschool LRE Expected (IE51-1E72)

* Age 5 and up, Kindergarten Grade Level - Count as School Aged

Student

* School Aged LRE Expected (IE13-1E39)

* Age 6 and up, Any Grade Level, including Preschool - Count as

School Aged Student

* School Aged LRE Expected (IE13-1E39)

EMIS

- N
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Reporting the FN270 Element
Updated October 31 IEP Outcome Element (FN270)
* The current IEP outcome and FN270 values should not be the same
* When the FN270 value is reported correctly the LRE that aligns with
the student’s age and grade level will appear in the column FED CCT
LRE CODE
* When reported incorrectly the FED CCT LRE CODE column will be
blank
| J K L M N (o] P Q
FED CCT LEGAL DISAB STDNT
STATUS Correct FED CCT FEDCCT DISTOF CNDTN AGE DIST LRE
CODE |~ | FED CCT STATUS CODE DESCR ~ | FLAG |~ |LRE CO[L~ RES IR~ CODE ~ | NUMBI ~ SRC COI ~  DIST LRE SRC DESCR |~
FCOO08 No errors identified in ODE processing \ IES1 404040 16 5 8 GE Record
FCOOO8 No errors identified in ODE processing Y IESS 404040 16 4 & GE Record
FCO002 Unable to translate LRE- must report FN270 element N 404040 1 5 8 GE Record
FCO002 Unable to translate LRE- must report FN270 element N Pl 404040 1 5 7 FN270 Override
/ EMIS
Incorrect TR
Alliance
26
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Additional Information on FN270 Reporting

* When completing the Federal Child Count, the Department will
review the LRE on the latest reported IEP event effective as of
October 31

* The value the FN270 element will take precedence
. * Reporting of an FN270 value is not limited to PS and KG

t |+ For this element to be valid for the Federal Child Count, the
student must already have an IEP reported to the Department

3 that is valid on October 31. If no reported IEP is valid on October
31, then the value in this element will be ignored

27

Additional Information on FN270 Reporting, cont’d

In general, the LRE will not change without a new IEP being
completed and reported, but there are some cases, especially
with IEPs reported in the prior year that are still in effect on
October 31, where the LRE could change

* Examples include but are not limited to

* a student whose parent originally consented to services but pulled the student
\ from services prior to October 31

g * situations where an expelled student is given an alternative placement that will
|l be in effect on October 31

ﬁ :“ * a preschool student (especially for those who are part time), a parental

| placement in a private preschool program could change the LRE for that
student

* Questions on FN270 reporting should go to the ODE EMIS HeEIhRJdesk

28
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FED CCT Status Code FCO003

Filter on FCO003
* CIEP most recent IEP - should be no disability (Warning)
* Source Code 8 - GE Record

* FED CCT FLAG - N
* Verify the CIEP event and confirm that the student’s disability code

is being reported as ending on the date of the CIEP event

* If the student’s disability code on the Student Attributes - Effective
Date (FD) Record is not reported as ended, make the correction
and submit updated EMIS data

EMIS

i
Alliance

29

FED CCT Status Code FC0004

Filter on FCO004
* No IEP reported for Oct 31 date (Fatal)
* Source Code 5 - No IEP Reported

* FED CCT Flag—N
* FED CCT LRE CODE — Blank
* Verify the student’s special education event records as of October 31

* Verify the most recent IEP was reported to EMIS
* Report an NIEP if appropriate

EMIS

i
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ODDEX Records

Special Education Data Tab
* Use to verify if the student’s IEP events were reported to EMIS

Records Single Student

Chio  2fe== Ohio District Data Exchange [ODDEX)

P r—

CEEY -

Home SOES- SCR- SCM-  Records CCP Tuition ODDEX Help  Log Out

b= Return 1o Summary m
Hame S50 Birthdate
Ewent Date Event Type Outcome Outcome Dates Hon-Compliance Secondary Planning Required Test Type Reported by LEA
oEm 2021 AIEF IE13 DEO12021 - 05052022 KA HA
Ll 3] RIEP IEST 0502021 - 05092022 NA NA STR
RIEP IE51 09i11/2020 - DAMD2021 A NA STR
028019 RIEP IE51 D2262019 - D252020 NA N& STR

31
~ NIEP Date Type - No IEP
| * NIEP events for expired or non-transferable IEPs
‘ * 10 - Student newly transferred in; IEP adoption determination not
complete; services being provided based on prior IEP
* 11 - IEP expired; new IEP not in place; services being provided
based on prior IEP
* NIEP events using the non-compliance reason of 12 can be
used until the end of the IEP that did not get reported to
EMIS
32
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FED CCT Status Code FCO005

Filter on FCO005

* Student does not meet inclusion filter in this district (Warning)

* Source Code 5 - No IEP Reported

* or Source Code 7 - FN270 Override

* or Source Code 8 - GE Record

* FED CCT Flag—N
* Shared students can have this Status Code at the educating district
* Shared students where |IEPs are not reported can also have this

Status Code with Source Code 5 — No IEP Reported

* Refer to the Federal Child Count Report Explanation, section “Include
in USDOE Count”

EMIS

TN
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FED CCT Status Code FC0005, cont’d

Filter on FCO005

* Student does not meet inclusion filter in this district
(Warning)
* Source Code 9 — How Received =6
* FED CCT Flag—N
* Non-Public special education students receiving related
services from reporting district with No IEP reported on
October 31
* Report does not consider ISPs

* If no IEP in place on October 31, then the student is not included in
the FCC

EMIS

TN
Alliance
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Multiple District Tie Breakers

1. Will count at Buckeye United if reported by Buckeye United (060988)
2. Will count where Reporting IRN = District of Residence IRN
~OR~ counts where Reporting IRN is reporting a How Received code of
M (Community School) or K (STEM District)

3. If multiple entities are claiming the student in the same way (as #2
above), then the student is included at the entity with the later
admission date

4. If entities are claiming the student in the same way (as #2 above) and
reporting the student with the same admission date, then the student
will not count for any district

EMIS

i
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FED CCT Status Code FCO006

Filter on FCO006
 Student counting in alternative district - does not count in your
district (Warning)
* Source Code 5 — No IEP Reported - verify if special education events need to
be reported for this student
* or Source Code 7 - FN270 Override
* or Source Code 8 - GE Record
* or Source Code 9 - How Received =6
* or Source Code A - Sent Reason AU or JP
FED CCT Flag - N
* Student counts at the IRN in the FED CCT ALT IRN column
* Review data in ODDEX to compare how data is being reported
* Communicate with the alternative district to determine how this
student should be reported

EMIS

i
Alliance
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FED CCT Status Code FCO007

Filter on FCO007

* Student excluded -conflict in where student should count (Fatal)
* Source Code —7 FN270 Override
* Or Source Code — 8 GE Record
* FEDCCT Flag-N
* Could not determine where this student should count, so the student
will not be counted at either entity
* Review data in ODDEX to compare how data is being reported by both
entities
* Communicate with the other entity to determine how this student
should be reported

EMIS

TN
Alliance
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FED CCT Status Code FCO008

Filter on FCO00S8

* No errors identified in ODE processing (Informational)
* Source Code 7 — FN270 Override
* or Source Code 8 — GE Record
* or Source Code 9 — How Received = 6
* or Source Code A — Sent Reason = AU or JP
* or Source Code B — Changed to DYS LRE (appears on Buckeye United FCC Report)
* or Source Code C— How Received = 6 and Grade = PS
* FED CCT Flag-Y
* Data for the students should be reviewed for accuracy
* Apply filters to verify elements such as disability conditions and LREs

* District staff can be very helpful in verifying data accuracy and
completeness

EMIS

TN
Alliance
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Quick Check

The Federal Child Count Detail
report will display students
who are and who are not
included in your count. The
report will also indicate
students with issues
preventing them from being
included. Check this report
often as it can be affected by
another entity’s EMIS
reporting.

* Have all status codes been
reviewed, and all reporting issues
corrected?

* When corrections have been
made in the student information
system (SIS), has that updated
data been submitted to EMIS?

* Based on inclusion criteria are all
of your special education students
being counted correctly?

EMIS

o i
Alliance

Troubleshooting
~ the Federal Child Count Statement of
| Assurances Report
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Open the FCC Statement of Assurances Report

A B C
DISAB Format the report
CNDTN STUDENT by wrapping the
| 1 [CODE  DISABILITY DESCR COUNTS text in the header
‘\ 2 |- 3, 4, and 5 Year Olds With a disability (Any) 72 extin
\ 3 01 Multiple Disabilities (other than Deaf-Blind) 31 row and expanding
| 4 02 Deaf-Blindness 1
l 5 03 Deafness (Hearing Impairment) 9 a" COIumnS
| ‘ 6 04 Visual Impairments 3
[ 7 05 Speech and Language Impairments 81
f: { 8 06 Orthopedic Impairments 7
i ;V‘ l‘ 9 08 Emotional Disturbance (SBH) 56
‘|u‘ 10 09 Intellectual Disabilities (Formerly Mental Retardation or -see Manua 99
f1 11 10 Specific Learning Disabilities 442
| 12 12 Autism 75
‘l 13 113 Traumatic Brain Injury (TBI) 3
[ 14 14 Other Health Impaired (Major) 1
15 |15 Other Health Impaired (Minor) 198
16 16 Developmental Delay 0 EMIS
T 41
Alliance
41
Understanding Statement of Assurances
* The report includes
* only students who have a FED CCT Flag=Y
\ * all students age 3 to 5 in the first category
\ * students age 6 to 21 in each disability specific category
| . Using the above criteria, the next series of slides will match
[ ' the FCC Detail Report against the FCC Statement of
0 { Assurances Report

* When you are told that the counts on this report are
incorrect, filtering allows you to show which students are
included or not included

EMIS

Il V)
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- Filter on FCC CCT Flag

D E F G H I J K L
. FED CCT
STATUS FEDCCT  FED CCT

ssiD ~|EmisID |~ |Last Nar{ =] First Narl + | Middle Nan( = | CODE  [-4| FED CCT STATUS CODE D ~|raG  [+]irecon/~
VK799 - “ebella Name FCO00S Mo error £ IE14
VX221 Select Y on the Name FCO008 TZ] SortZtoh 1E39
vz34s4 R Noerol . .o , [IE13
vizsas| FED CCT Flag Filter on FCODS  Noerror o 1£55
acsa1f . FCO00E  Noerrol IE13
OMLE6} the FCC Detall Report Name 008 Mo errot IES1
QC702 lyor—rrrrrrosr o e rrerrsrre—rrroomd Name | FCO0 NOErrol et Filters » IE13
CG9934758 | 123456938 Last Name First Name Middle Name FC0008 — o) e
UH3080776 | 123456947 Last Name First Name Middle Name FC0008 IE13
VK885 i i ame FCOD08 : EEE'“‘A”] IES1
0B663 ame FCO008  No errol IE39
| These are the students [ s noer =
EF103 : : ame FCO008  No errol IE13
VD254 who are included in ame FCO008  No errol IE14
UF355 the Statement of ame FCO008 No errot 1E39
wr114 ame FCO008  No errol 1E39

| us] Assurances Report ame FCO008  No errol IE51

i\ UG30 lame FCO00E  No errol 1E39
TR6407264 123457318 Last Name First Name Middle Name FCO008  No errol Cancel | |IE39
EW3403620 123457321 Last Name First Name Middle Name FC0003 MNo errot - IE13

|
|
|
|
- Add S d Filt Student Age N b
G H I J K L M N o
FEDCCT FED CCT LEGAL DISAB STDNT
STATUS FED CCT LRE DISTOF CNDTN AGE
First Nan v |Middle Nan| v | CODE| v | FED CCT STATUS CODE DESCR v |FLAG |-¥|CODE| ~ |RES IF ¥ | CODE ¥ | NUMBI T’
First Name Middle Name FC0008 No errors identified in ODE processing 21 Sort Smallest to Largest
First Name Middle Name FC0008 No errors il z
ad SortL. t to Smallest
First Name Middle Name FCO008 No errors i Select ageS 3, 4 and AL St Largestto Smake
First Name Middle Name FC0O008 No errors i Sort by Color >
Fist Name Widdle Name rcooos noerors| 3 ON the Student Age
First Name Middle Name FC0008 No errors i H )
First Name Middle Name FC0O008 No errors i Number Fllter + 3% Clear FitterFrom "STONT AGE NUMBER
First Name Middle Name FC0008 No errors identified in ODE processing )
First Name Middle Name FC0008 No errors identified in ODE processing Number Filters >
First Name Middle Name FC0008 No errors identified in ODE processing
First Name Middle Name FC0008 No errors identified in ODE processing - be
First Name Middle Name FC0008 No errors identified in ODE processin; = (Select All) A
vi3
First Name Mi . .
arename wid These students are included in the 3, 24
154}
First Name Mi . - oge =
- - 6
e wd 4, and 5-year-olds with any disability ! .
First Name Mi ]
on the Statement of Assurances report 8
First Name Mi 19
| \ First Name Middle Name FC0008 No errors identified in ODE processing 1 10 v
i\ First Name Middle Name FC0008 No errors identified in ODE processing 1
First Name Middle Name FC0008 No errors identified in ODE processing ) Cancel
\ — s — e - EMIS
\
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| Matchlng Data Between Reports

‘ 2. This will match the count on the Statement of Assurances. | ¢

| leooe oesca ~IFLAG [ LRE CODI= | RESIAN =] CODE [~ | NUMBER -¥]SAC COD) = |DiST LAE SAC DESCR = ALT1an =] ADwsH
| /| fiecin ooeprocessing [y css a0 05 ss e Record 20201
\} | [iedinODE processing |¥ iEss aoa0a 05 a8 GE Record 202004
\ i in ODE processing ¥ ess anacan’is s G Record 20210
1. From the filtered students on the FCC Detail Report
select a range of cells and see the “count” appear at
the bottom of the spreadsheet.
| [t oo procesive [ N s0i0a0 16 5a % Record 200
| fied in ODE processing (¥ 04040 05 as GE Record 202004
| fied in ODE processing (¥ 04040 05 as GE Record 2020-04
e n D€ procesing [¥ wan i e hert ol
fied in ODE processing |¥ 38 GE Record 2021-08
ied in ODE processing ¥ 58 GE Record 2021-04
| fied in ODE processing ¥ ez 404040 05 48 GE Record 2021-08
fied in ODE processing ¥ IESS 404040 05 58 GE Record 2020-14
ed in ODE processing |¥ ies5 404040 05 GE Racord 2020-04
\ ied in ODE processing [¥ 13 20404005 58 GE Recard 2021-0f
1\

DISAB

CNDTN STUDENT
1 CODE DISABILITY DESCR COUNTS
2 |- 3, 4, and 5 Year Olds With a disability (Any) T 7
301 Multiple Disabilities (other than Deaf-Blind) 31
4102 Deaf-Blindness 1
5103 Deafness (Hearing Impairment) 9
6 04 Visual Impairments 3
705 Speech and Language Impairments 81
8 06 Orthopedic Impairments 7
9 08 Emotional Disturhance (SBH) 56
10 09 Intellectual Disabilities (Formerly Mental Retardation or -see Manua 99
1110 Specific Learning Disabilities 442
1212 Autism 75
1313 Traumatic Brain Injury (TBI) 3
14114 Other Health Impaired (Major) 1
15115 Other Health Impaired (Minor) 198
16 16 Developmental Delay 0
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Home  Inset  Pagelayout  Formulas  Data
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H [ Sl Sie by Sice

arnnoaT

l:l D I:J Formula Bar Q [E)ﬂ —
Normal Page Break Page Custom  [] Gridlines (/] Headings Zoom 100% Zoomto  New \ Arrangef Freeze
Preview Layout Views Selection  Window! Panes~
Workbook Views Show Zoom
K3 - e
A B
DISAB
CNDTN
1 CODE DISABILITY DESCR
2 3, 4, and 5 Year Olds With a disability (Any)
3 01 Multiple Disabilities (other than Deaf-Blind)
4 02 Deaf-Blindness
5 03 Deafness (Hearing Impairment)
6 04 Visual Impairments
7 05 Speech and Language Impairments
8 06 Orthopedic Impairments
9 08 Emotional Disturbance (SBH)
10 |09 Intellectual Disabilities (Formerly Mental Retardation or -see Manua
11 |10 Specific Learning Disabilities
\ 12 112 Autism
‘, \ 13 |13 Traumatic Brain Injury (TBI)
i\ 14 14 Other Health Impaired (Major)
\ 15 |15 Other Health Impaired (Minor)
“\ 16 |16 Developmental Delay

© Tell me what vou want to do

pamsew “Vertical” and “OK”

With two spreadsheets
open at the same time,
from the View tab select
“Arrange All” and then

C D E F

STUDENT
COUNTS
72
31
1 Arrange
9 O Tilea
3 O Harizontal

(@) Vertical
81 O Cascade

7 ] Windows of active workbook
56 Gancel

99
442
75
3

1

198
0
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" Arrange All cont’d

H %~

File  Home Insett Pagelayout Formulas Data Review NESW Developer Help ACROBAT Q Tellme

Elizabeth D:

9 share File

E (FCCD-001) Federal Child Count Detail DEMO -

PageLayout  Formulas

Brmeion || Q [3 [ | St 50 05 = “Arrange All” allows
Normsl Page Breck 5] custom views | MW | Zoom 100% SZn‘nn:!n EI:::::::LV 5 wiv:mh Macros st 7\.V B I U~ - &-A- =5 b h d h
review election indows -~ -
s s | o | : oth spreadsheets to
K3 - £ NI - £ | Noerorsid be viewable at the
.
A 8 SRS = £ < 2 same time
DISAB
CNDTN STUDENT SEVERITY
1 |CODE DISABILITY DESCR COUNTS 1 [LEAIRN[~]BIdgIRN[~]CODE  [-]ssID  [~|EmisID [~|Last Name [~ ]First Name [ Middle Name [~
2 |ass0s0 201000 1 VX2210168 | 123456822 LastName  FirstName  Middle Name
2 - 3,4, and 5 Year Olds With a disability (Any) 72| |3 aos0a0 101000 UF3557988 | 123457014 LastName  FirstName  Middle Name
3 01 Multiple Disabilities (other than Deaf-Blind) 31 4 [s04040 101010 1 TVB072204 123457765 LastName  FirstName  Middle Name
4 02 Deaf-Blindness 1 5 [ass0s0 101000 1 TC8584040 | 123458858 LastName  FirstName  Middle Name
. 5 6 [aosos0 101000 1 TF6201943 123458912 LastName  FirstName  Middle Name
5103 Deafness (Hearing Impairment) 9 7 |s04040 101010 | LRAS66079 | 123459026 LastName  FirstName  Middle Name
6 |04 Visual Impairments 8 |a0a040 101010 | TL4612853 123459178 LastName  FirstName  Middle Name
7 05 Speech and Language Impairments 81 9 [assss0 101000 1 HT4306805 123459269 LastName  FirstName  Middle Name
" . 10|a0a040 101000 1 VP4TS1649 123459271 LastName  FirstName  Middle Name
8 106 Orthopedic Impairments 11|a0a040 101000 1 714940830 | 123459316 LastName  FirstName  Middle Name
9 |08 Emotional Disturbance (SBH) 56 | |12]a0e0s0 101000 1 PR7313505 | 123459323 LastName FirstName  Middle Name
10 09 Intellectual Disabilities (Formerly Mental Retardation or -see Manua 99 13 |404040 101010 ! TV9275263 123459334 LastName  FirstName  Middle Name
1110 Specific Learning Disabilities 247 14|a04040 101000 | XD6766178 | 123459352 LastName  FirstName  Middle Name
: 15|a04040 1201010 | V23607326 123459264 LastName  FirstName  Middle Name
1212 Autism 75 16|404040 1201010 | VD9410391 | 123459267 LastName  FirstName  Middle Name
13 13 Traumatic Brain Injury (TBI) 3 17|a0a040 101000 | TZ6626581 123459372 LastName  FirstName  Middle Name
14 14 Other Health Impaired (Major) 1 18|a0ca0s0 101000 1 TR2714158 | 123459295 LastName  FirstName  Middle Name
. 5 19|a0a040 101000 1 JB1322486 | 123459425 LastName  FirstName  Middle Name
15|15 Other Health Impaired (Minor) 198 | ls0/aosos0 101000 1 UQ3312975 | 122459516 LastName  FirstName  Middle Name
16 |16 Developmental Delay o 21|a0s040 101010 1 BMA655536 123459538 LastName  FirstName  Middle Name
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Change the Student Age Filter

F G H | J
FED CCT
STATUS
Last Nan ~ |First Nan ~ |Middle Nan| ~ |CODE| ~ | FED CCT STATUS CODE DESCR =

Last Name First Name Middle Name FCO008 Mo errors identified in ODE processing
Last Name First Name Middle Name FC0O008 No errors identified in ODE proc:

Last N identified in OD
Leave the FED CCT Flag ;

Last M identifie DE processing
Last id led in ODE processing

Last N column filter set to Tdentified in ODE processing

Last identified in ODE processing
Last M Show Only Y Values identified in ODE processing
Last I identified in ODE processing

Last Name First Name Middle Name FCO008 No errors identified in ODE processing
Last Name First Name Middle Name FCO0008 No errors identified in ODE processing

Last . rocessin,
| Change the filter for the Student e
o:| Age Number column to include  [roeone
= all ages except 3, 4, and 5 P recneang
Last Name ame Middle Name o errors identifie processing

Last Name First Name Middle Name FCO008 No errors identified in ODE processing
Last Name First Name Middle Name FCO008 No errors identified in ODE processing
Last Name First Name Middle Name FC0O008 No errors identified in ODE processing

FED CCT FED CCT

< < << < << << <<=

L M N (o] P
LEGAL DISAB STDNT DIST LRE
DIST OF CNDTN AGE SRC
FLAG J_LRECOE‘ RESIRN| ~ |CODE |~ NUMEEE_CUDE hal'!
2] sortSmallest to Largest 8
8
Z] sertlLargestto Smallest s
Sort by Celor > 8
it
— 7H
! 8
8
Mumber Filters > 8
8
Si h
carc o o
- M (Select All) A g
04 :
s g
7H
7H
8
8
v g
8
Cancel 7H

< < < < < < =<

K
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| Add a Third Filter

G H I J K L M N o P
FED CCT LEGAL DISAB STONT DIST LRE
STATUS FEDCCT FEDCCT DISTOF  CNDTN AGE SRC
First Nan ~ /Middle Narr ¥ CODE ~ FED CCT STATUS CODE DESCR ~ |FLAG ¥/ LRECOC v |RESIRN v CODE_ |-¥| NUMBEI ~ CODE |~
First Name piialal = — - biadiedDE processing zl Sort Smallest to Largest 10 8
pevame) Add a third filter in A
First Name 3 8
First Name ort by Color > 9 8
rreavene) the DISAB CNDTN —
flrst Nome co DE COI u mn DE processing \7 Clear Filter From "DISAB CNDTN CODE" 2 £
First Name DE processing 15 8|
First Name Middle Name FC0008 No errors identified in ODE processing 15 8§
First Name Middle Name FC0008 No errors identified in ODE processing Number Filters > 17 8|
First Name Middle Name FC0008 No errors identified in ODE processing 16 8
First Name Middle Name FC0008 No errors identified in ODE processing i be 18 8
First Name Middle Name FC0008 No errors identified in ODE processing 4 ] (Select All) al 15 8|
First Name_Middle Name FC00028 _No errorsidentifiedin 15 8
First Namd . i 7 14 8|
arnamd S€lECt ONeE disability : -
First Nam¢ H ODE processing 6 5 7
First Nam¢ COde at a tlme ODE processing 8 7 7
First Name Middle Name FCO008 No errors identified in ODE processing 9 17 8
First Name Middle Name FC0008 No errors identified in ODE processing 10 v 17 8|
First Name Middle Name FC0008 No errors identified in ODE processing 6 7|
First Name Middle Name FC0008 No errors identified in ODE processing Cancel 8
First Name Middle Name FCO008 No errors identified in ODE processing 1 7| EMIS
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- Match the Data Between the Reports

A B C N =] P Q R s
DISAB repcor |encorine_|meror |owom |stonTace | ane T
FLAG -¥|CODE ~|RESIRN | ¥ |CODE |-F|NUMBER T CO| * |DIST LRE SRC DESCR |~ |ALTIRN |~ | DATE
CNDTN el ——r O - oo
CODE DISABILITY DESCR COUNTS k = dodods 1 s A sant Reason = Al or /P 2000,
-- 3, 4, and 5 Year Olds With a disability (Any) ]| jes o0t 1 1 A Sent Reason - AU orJp Doito,
01 Multiple Disabilities (other than Deaf-Blind) = 31|_‘: e A2 - BgE Racarg D000
et NE =i & o= =
03 Deafness (Hearing Impairment) 9 | 15 a0 1 % sorrecor
04 Vlsual Impalrmems 3 ¥ 11 404040 1 12 8 GE Record 00:00.
¥ 1IE15 404040 1 8 8 GE Record 00:00.
05 Speech and Language Impairments 81| [¢ = —_ = o ouoo.
| . N H 0:00.
- " T 7| || 1. From the filtered students on the |-
2. This will match the count on 56| [ .
" ¢ v 99| |- | FCC Detail Report, select a range vao.
the Statement of Assurances. v « ”
w2 | || of cells and see the “count” appear |-«
12 Autism 750 v 0:00.
— v | at the bottom of the spreadsheet. |-
13 Traumatic Brain Injury (TBI) 3 I o10:
14 Other Health Impaired (Major) 1l s _:::; o 12 ooree
15 Other Health Impaired (Minor) 198
16 Developmental Delay 0 B
Cowm S @ m
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Quick Check

The Federal Child Count
Statement of Assurances
Report is derived from the
same data that is on the FCC
Detail Report. Using filters,
you can match the data
between the reports. The
Statement of Assurances is
sometimes requested by
auditors.

* Can you match the data between
the two reports using filters?

* Are you seeing the numbers of
students that you were expecting?

* Has this data been shared with
others in your district?

EMIS

i
Alliance
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Summary

* The FCC Reports contain both data to verify and issues to

correct

* Some issues can be corrected, and some are simply stating
the fact that the student cannot be included in the count

* Work with district staff to verify that the data is both correct

and complete

* “No errors” does not necessarily mean that your data is

accurate

EMIS

i
Alliance
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Resources

* Federal Child Count Detail Report and Federal Child Count
Statement of Assurances Report Explanation
* ODE Home > Data > EMIS > Documentation > EMIS Validation and
Report Explanations
* EMIS Manual
* ODE Home > Data > EMIS > Documentation > EMIS Manual

* Your district staff
* Your ITC

EMIS

-:m - s
Alliance
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If you would like a certificate of attendance for this
training, you must complete the below feedback form
within 5 business days of this training
https://tinyurl.com/EA-District-Feedback
EMIS
T 54
Alliance
54
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